Seminar:

L2Android: Plattform fur mobile Gerate®

Publishing of Android Applications

von
Artiom Wulis

Wintersemester 2009/2010

Betreuer:
Julian Kunkel

Universitat Hamburg
Department Informatik
MIN Fakultat
AB Wissenschaftliches Rechnen



Inhaltsverzeichnis

Inhaltsverzeichnis
L BN @I UG ettt 3
2 Publishing VOrauSSELZUNGEN ......uiii i it e e et s e e e e e e e eaa e e eaes 4
2.1 Publishing CheCKIStE: ......uuuuiiiie e e e e e e et eaaeeaannes 4
2.1.1  Anwendung auSgiebig TESIEN .........uuuuuuiiiiiiiiiiiiiiii e 5
2.1.2 Endbenutzer-Lizenzvereinbarung hinzuflgen............ccccviiiiii e, 6
2.1.3 Icon und Label SpPezifiZieren ... 6
2.1.4  Logger UNd DEDUGQEN .......uuuuuiiiiiiiiiiiiiiiiii s enee 6
2.1.5  Anwendung VEISIONIEIEN .........cuuuuiiiieeeeieeiiiiiee s e e e e e e et a e e e e e e e e easata e s e eeaaeeaanees 8
2.1.6  ANWENAUNG SIGNIEIEIN .. .uuuiiiiiiiiiiiiiietieiee bbb nensnnnnne 11
3 PUBIISNING e 17
I N o To [ o (o [N = o (] PP P PP PPPPPPPPPPP 17
T 1 0o [ [T - | PRSPPI 17
4 LIteratUrVerZEIiCHNIS ....uiiiiiiiii ittt e e e e e e e e e 19



1 Einleitung

1 Einleitung

Mit der zunehmender Beliebtheit von Android Betriebssystem, wachst auch die ,Android-
Gemeinschaft und somit auch die Anzahl potentieller Entwickler/innen. Eine erste Anwen-
dung ist schnell geschrieben. Will man spater diese auf dem Endgerat tUbertragen, oder so-
gar kommerziell auf Android Market vermarkten, so missen einige wichtige Vorkehrungen
gemacht werden.

Diese Seminararbeit kann als Einfihrung und Anleitung fur die Veréffentlichung von Android
Anwendungen auf den Endgeréaten und Android Market betrachtet werden.

Da Android Anwendungen in JAVA geschrieben werden, wird hier Eclipse (IDE), die sich als
Standard-Etwicklungsumgebung fir JAVA etabliert hat, verwendet. Daher werden zumindest
grundlegende Eclipse Kenntnisse vorausgesetzt.



2 Publishing Voraussetzungen

2 Publishing Voraussetzungen

Bevor man seine Anwendung veroffentlichen kann, missen bestimmte Voraussetzungen
erfullt werden. Nachfolgende Liste, stellt grob die Einzelne Schritte dar, die im weiteren Text-
verlauf naher erlautert werden. Es mussen jedoch nicht alle Punkte der Liste, wie z.B. Tes-
ten, abgearbeitet werden, es ist aber empfehlenswert alles zu machen, zumal Testen der
Anwendungen zu jedem guten Programmierstil dazu gehort.

2.1 Publishing Checkliste:
1. Anwendung ausgiebig Testen
2. Endbenutzer-Lizenzvereinbarung hinzufiigen
3. lcon und Label spezifizieren
4. Logger und Debugger ausschalten, temporare. Dateien l6schen
5. Anwendung versionieren

6. Anwendung kompilieren und signieren

Im weiteren Verlauf wird Eclipse mit ADT Plugin (Android Development Tools) und Android
SDK benutzt. Eine Installationsanleitung der beiden Komponenten findet man auf der
Android Developerhomepage®.

1 http://developer.android.com/sdk/installing.html
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2 Publishing Voraussetzungen

2.1.1 Anwendung ausgiebig Testen

Neben den Unit Test, ist es empfehlenswert die Android Anwendung auf mdglichst vielen
Endgeraten zu testeten.

Bei der Vielfallt der Android Geraten, ist logisch, dass man nicht alle Gerate besitzt. Daher
gibt es vorgefertigte Android Virtual Devices (AVD). Eigene AVD's kénnen selbstverstandlich
auch erstellt werden. Dabei kann man zwischen den verschiedenen Android OS Versionen
auswahlen.

Seltene oder nicht vorhandene Gerate, kénnen mit dem Emulator weitestgehend emuliert
werden. Es stehen unter anderem folgende Startparameter: -dpi, -netspeed, -cpu-delay, zur
Auswahl.

Emulator Startparameter findet man unter Eclipse: Window > Preferences > Launch > De-
fault emulator options.

-
# ' 5554:android_froyo

ANl @ 8:52em

| See all your apps.
Touch the Launcher icon.

Abbildung 1. Android AVD ohne Skin mit Android OS. 2.2

Eclipse mit ADT Plugin bietet zwar einen machtigen Android Emulator, doch dieser kann ein
echtes Android Gerat nicht ersetzen. Physische Eigenschaften wie Netzqualitat, Bildschirm-
bedienung, Akkuverbrauch und vieles mehr, sind von Gerét zu Gerat sehr unterschiedlich.
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2.1.2 Endbenutzer-Lizenzvereinbarung hinzufiigen

Fur die Veroffentlichung auf Android Market ist eine Endbenutzer-Lizenzvereinbarung nicht
notig. Will man aber eine EULA haben, so existieren im Internet viele Anleitungen mit Bei-
spielen, wie eine EULA auf Android OS realisiert werden kénnte.

2.1.3 Icon und Label spezifizieren

Jede Anwendung braucht sowohl einen Namen, als auch ein Logo. Der Name und das Logo
sind Uberall, wie z.B. auf Android Market, Programmanager und Homescreen sichtbar.

Name android:label="@string/app_name" und Logo android:icon="@drawable/icon" werden
in der AndroidManifest.xml unter application definiert.

<application
android:icon="@drawable/icon"
android:label="@string/app_name" >
</application>

Auszug aus AndroidManifest.xml

Wahrend der Entwicklung mit Eclipse, gibt es im typischen Android Projektverzeichnis den
res Ordner. Dieser hat unter anderem diese Ordner: drawable-hdpi, drawable-mdpi, drawab-
le-Idpi, values. Die drei drawable Ordner beinhalten in unserem Beispiel eine Datei icon.png.
Die drawable Ordner haben drei Endungen: hdpi (hohe Auflosung), mdpi (mittlere Auflésung)
und Idpi (kleine Auflésung). Dementsprechend muss die GroRRe der Bilddatei angepasst wer-
den. Der Ordner values beinhaltet die Datei strings.xml in der die Variable app_name dekla-
riert ist.

<resources>
<string name="app_name">Hello, Android</string>
</resources>

Auszug aus strings.xml
2.1.4 Logger und Debugger
Logger und Debugger sind in der Entwicklungsphase unverzichtbar. Diese, sowie evtl. tem-

porare Dateien mussen vor der Vero6ffentlichung deaktiviert und geléscht werden.

Debugger wird in der AndroidManifest.xml ausgeschaltet.

<application
android:debuggable="false"
</application>




2 Publishing Voraussetzungen

Fur diejenigen, die den puren Quelltext von AndroidManifest.xml flrchten und lieber mit ei-
nem Grafischen Editor arbeiten, bietet Eclipse mit Android ADT eine grafische Oberflache, in
der man bequem alles verwalten kann. Im folgenden Textverlauf werden sowohl Ausschnitte
aus AndroidManifest.xml, als auch Screenshots von Eclipse zu sehen sein.

I HelleAndroid Manifest 53 =B
Android Manifest Application
~ Application Toggle

The application tag describes application-level compenents contained in the package, as well as general application attributes.
Define an <application> tag in the AndroidManifest.xml

~ Application Attributes
Defines the attributes specific to the application.

Name Persistent -
Theme Enabled -
Label @string/app_name Debuggable false -
Icon @drawableficon Manage space activity
Description Allow clear user data -
Permission - Test only -
Process Backup agent
Task affinity Allow backup -
Allow task reparenting + Kill after restore -
Has code * Restore needs application -
Application Nodes @ [E @ @ [E @ @ Az
[A) HelloAndroid (Activity) hr
Remove...
Up
Down

Manifest | Application | Permissions | Instrumentation | AndroidManifest.xml

Abbildung 2. AndroidManifest.xml (Application Ansicht) in der Grafischen Oberflache
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2.1.5 Anwendung versionieren

Bevor wir zum eigentlichen Versionieren kommen, stellt sich die Frage wozu missen wir
unsere Anwendung Uberhaupt versionieren.

Endbenutzer missen die Mdglichkeit haben, die Programmversion zu sehen. Diese Méglich-
keit ist sehr sinnvoll, wenn man ein Update / Upgrade installieren mdchte oder in einem Sup-
portfall als Entwickler Hilfestellung leisten will.

Fremde und auch eigene Anwendungen missen ebenfalls die Versionsangaben von instal-
lierten Anwendungen sehen kénnen. So kann Inkompatibilitéat vermieden werden.

Will man die Anwendung auf Android Market oder &hnlichen Seiten verdffentlichen, so muss
man ebenfalls Versionsangaben machen.

Wie bereits erwahnt, missen einigen Versionsangaben gemacht werden bevor die fertige
Android Anwendung kompiliert wird. In der Android Manifest gibt es flnf Attributen.

Zwei davon sind android:versionCode und android:versionName.

Der android:versionCode ist ein Integer Wert und ist somit fir andere Anwendungen und
Systeme evaluierbar. Dabei gibt es keine Unterscheidung zwischen kleineren oder gré3eren
Updates. Nach jedem Update wird der Wert um eins erhoht. Dieser Wert sollte fir Endan-
wender verborgen bleiben.

Fir die Endanwender ist android:versionName da. Dieser Wert ist ein String und ist somit fur
Anwendungen nicht evaluierbar. Dabei ist eine Unterscheidung zwischen kleineren und gro-
Reren Updates moglich. Glltige Werte von android:versionName sind z.B. 1.21 / 3a. Dem-
entsprechend sollte dieser Wert fiir die Endanwender sichtbar sein.

Man sollte immer die Werte fir android:versionCodend und android:versionName festlegen
und nach jedem Release auch beide erhdhen.

<manifest xmins:android="http://schemas.android.com/apk/res/android"
package="com.example.package.name"
android:versionCode="2"
android:versionName="1.1">
<application android:icon="@drawable/icon" android:label="@string/app_name">

</application>
</manifest>

Auszug aus AndroidManifest.xml
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Android Os prift nicht diese Versionsangaben. Es werden jedoch die SDK Versionsangaben
bei der Installation gepruft.

Benotigt die eigene Anwendung eine bestimmte Android Plattform Version oder ist fiir eine
bestimmte Version optimiert, so kann man das mit der der Android SDK Version festlegen.

Dafir sind die restlichen drei Attribute da, namlich android:minSdkVersion, andro-
id:targetSdkVersion und android:maxSdkVersion.

Wie der Name schon sagt, gibt die mindSdkVersion die minimale Android Plattform Version
an, welche die Anwendung braucht. Bendtigt eine Android Anwendung z.B. Flashfunktionali-
tat, welche erst ab Android 2.2 (Api Level 8), so muss die minSdkVersion den Wert 8 haben.

Die targetSdkVersion gibt an, fur welche Android Version die Anwendung programmiert und
optimiert ist. Es bedeutet jedoch nicht, dass die Anwendung auf friheren Versionen nicht
lauft sondern, dass eventuelle Funktionalitaten, die mit der TargetSdkVersion erschienen
sind, in den friheren Versionen nicht genutzt werden kdnnen. Die TargetSdkVersion, ersetzt
jedoch nicht die minSdkVersion.

Vollstandigkeitshalber sollte die maxSdkVersion erwahnt werden, diese Angabe findet in der
Praxis jedoch keinen Gebrauch. Die maxSdkVersion stellt die Obergrenze da, also bis zu
welcher Android Version die Anwendung laufen darf.

Folgendes Szenario verdeutlicht die Problematik mit maxSdkVersion.

Auf dem Endgerat mit Android Version 2.1 (Api Level 7) ist eine Anwendung installiert wel-
che als maxSdkVersion den Wert 7 hat. Nun kommt ein Update auf Android Version 2.2 (Api
Level 8) heraus. Nach der Installation des Updates funktioniert das zuvor installierte Pro-
gramm nicht mehr und wird geléscht.

Da alle zukunftigen Android Versionen mit den friiheren Versionen kompatibel sind, macht es
keinen Sinn die maxSdkVersion zu benutzen. Das empfehlen auch die Android Entwickler
auf der Entwicklerhomepage.

Die Priifung der maxSdkVersion wird ab Android 2.0.1 nicht mehr gemacht.

<manifest xmins:android=http://schemas.android.com/apk/res/android
<application ...</application>
<uses-sdk android:minSdkVersion="3" android:targetSdkVersion="7"/>
</manifest>

Auszug aus AndroidManifest.xml



2 Publishing Voraussetzungen

< HelloAndroid Manifest 52 . [J] HelloAndroid.java al strings.ml =B

Android Manifest

* Manifest General Attributes

Defines general information about the AndroidManifestxml

Package com.example.helloandroid
Wersien code 1
Wersien name 1.0

Shared user id

Shared user label

Manifest Extras @ @ ® @ @ A= Attributes for Uses Sdk

(U) Uses Sdk

(U) The uses-sdk tag describes the SDK features that the containing
package must be running on to operate correctly,

i — Min SDK version 3
Target 5DK version 7

Mazx SDK version

Down

* Exporting
To export the application for distribution, you have the following options:
® e the Export Wizard to export and sign an APK
® Export an unsigned APK and sign it manually
w Links
The content of the Android Manifest is made up of three sections. You can also edit the XML directly.
[ﬂ] Application: Activities, intent filters, providers, services and receivers,
[E Permission: Permissicns defined and permissions used.
m Instrumentation: Instrumentation defined.
AML Source: Directly edit the AndroidManifest.xml file,
Documentation: Documentation from the Android SDK for AndroidManifest.xml,

Manifest| Application | Permissions | Instrumentation | AndroidManifest.xml

Abbildung 3. AndroidManifest.xml (Manifest Ansicht) in der Grafischen Oberflache
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2.1.6 Anwendung signieren

Bevor wir zum eigentlichen Signieren kommen, sollte noch erwéhnt werden, dass alle
Android Anwendungen signiert sein mussen. Dabei kann man gliicklicherweise eigene Zerti-
fikate zum Signieren benutzen und ist somit auf teurere Zertifizierungsstellen nicht angewie-
sen. Selbstverstandig kann man die kostenpflichtigen Zertifizierungsstellen auch benutzen.
Android Os pruft beim Installieren, ob die Anwendung signiert ist. Das dient der Sicherheit
und soll das Vertrauensverhaltnis zwischen den Entwickler und Endanwender starken. So
kann man als Endanwender selber prufen, ob die Anwendung wirklich von dem Hersteller
kommt, oder es sich um einen Trojaner handelt.

Es gibt zwei wichtige Aspekte, die bei der Signierung bedacht werden mussen.

Zum einem ist es empfehlenswert alle Anwendungen mit demselben Zertifikat zu signieren.
Mochte man in Zukunft Updates fir die eigene Anwendung herausbringen, so muss man das
Update ebenfalls mit demselben Zertifikat wie die Hauptanwendung signieren. Beim Installie-
ren pruft das Android Os nach, ob die Zertifikate Ubereinstimmen. Sollte das nicht der Fall
sein, wird Android Os sofern mdglich, das Update als eigenstandiges Programm und nicht
als Update installieren. Dies ist jedoch nicht der Sinn eines Updates.

Android Os erlaubt den Anwendungen, die mit demselben Zertifikat signiert sind, in demsel-
ben Prozess zu laufen. Dabei werden die Anwendungen vom System wie eine Anwendung
behandelt. Diese Mdglichkeit erlaubt Anwendungen wie z.B. Office Programme, modular zu
gestallten. Dadurch kann man einige Module z.B. erweitern, updaten und ldschen.

Ein weiterer Vorteil besteht darin, dass das Android Os ,Signaturbasierte Berechtigungen®
unterstitzt. Programme mit demselben Zertifikat kbnnen Funktionalitaten des anderen be-
nutzen. Ferner ist es auch madglich, auf sichere Art Daten untereinander auszutauschen.

Zum anderem ist es ebenfalls empfehlenswert die Giltigkeitsdauer des Zertifikates voraus-
schauend zu vergeben.

Wie oben schon beschrieben, ist es in der Praxis tblich Updates oder Upgrades herauszu-
bringen. Dabei darf das Zertifikat nicht ablaufen, bevor das eigentliche Programm noch vom
Hersteller noch unterstiitzt und erweitert wird. Hat man mehrere Anwendungen, so muss das
Zertifikat so lange gultig sein, bis die letzte Anwendung noch vom Hersteller unterstttzt wird.

Mdéchte man die eigene Anwendung auf Android Market veroffentlichen, so muss das Zertifi-
kat frihestens nach 22.10.2033 enden.

Debug mode

Wahrend der Entwicklung und Testphase braucht man sich nicht darum zu kimmern, wie die
Anwendungen signiert werden. Das Signieren Ubernimmt das Eclipse. Dabei wird die An-
wendung in dem Debug mode kompiliert und mit dem Debugzertifikat signiert. Dieses De-
bugzertifikat ist 365 Tage gliltig. Sollte die Entwicklungsphase Uber ein Jahr dauern, so muss
dann der Schlissel oder der ganze Keystore geléscht werden. Danach erzeugt Eclipse wie-
der einen Debugzertifikat, der ein Jahr giltig wird.

11
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Ein Keystore ist ein Zertifikatspeicher, der verschiedene Schlissel zum Ver- und Endschlus-
seln speichert. Die Zertifikate werden durch den eindeutigen Aliasnamen unterschieden.
Wenn eine Anwendung in Debug Mode kompiliert wird, werden immer wieder die gleichen
Daten fur das Signieren benutzt.

Keystore name: "debug.keystore"

Keystore password: "android"

Key alias: "androiddebugkey"

Key password: "android"

CN: "CN=Android Debug,0=Android,C=US"

Debug Keystore und Schlisseldaten

Release mode

Moéchte man seine Anwendung auf viele Android Geréate installieren oder im Android Market
veroffentlichen, so muss die Anwendung im Release mode kompiliert werden. Anwendungen
die mit dem Debugzertifikat signiert worden sind, lassen sich nur auf den Geréaten installie-
ren, die an dem Computer angeschlossen sind. Ferner miissen die Gerate sich in dem De-
bugmodus befinden. Im Release mode kompilierte Anwendungen sind standardmé&nig nicht
signiert. Deshalb muissen dieser erst mal mit dem privaten Schliissel signiert werden.

Wenn noch kein privater Schlissel vorhanden ist, so lasst sich dieser mit dem Tool
Keytool.exe generieren. Keytool.exe liegt on JavaSDK/bin Ordner. Weitere Informationen zu
Privaten Schliissel und Keyool.exe findet man auf der Java Homepage?.

Fuhrt man keytool.exe mit dem Parameter

keytool.exe -genkey -v -keystore my-release-key.keystore -alias alias_name
-keyalg RSA -validity 10000

passiert folgendes:

Es wird ein Schlusselpaar bestehend aus privaten und 6ffentlichen Schliissel von Typ RSA
1024Bit (-keyalg RSA) erzeugt (-genkey). Dabei wird mit dem 6ffentlichen Schliissel ein
selbstsigniertes Zertifikat mit einer Guiltigkeit von 10000 Tagen erzeugt. Der private Schlis-
sel wird als ,alias_name® in dem neu erstellten Keystore namens my-release-key.keystore
gespeichert.

2 http://download.oracle.com/javase/1.5.0/docs/tooldocs/#security

12
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PS C:\Program Files\Java\jdk1.6.0_18\bin> keytool.exe -genkey -v -keystore my-release-
key.keystore -alias alias_name -keyalg RSA -validity 10000

Geben Sie das Keystore-Passwort ein:

Geben Sie das Passwort erneut ein:

Wie lautet Ihr Vor- und Nachname? [Unknown]: Heinz Mustermann

Wie lautet der Name lhrer organisatorischen Einheit? [Unknown]: Android developer
Wie lautet der Name lhrer Organisation? [Unknown]: Uni HH

Wie lautet der Name lhrer Stadt oder Gemeinde? [Unknown]: Hamburg

Wie lautet der Name Ihres Bundeslandes oder Ihrer Provinz? [Unknown]: Hamburg

Wie lautet der Landescode (zwei Buchstaben) fir diese Einheit? [Unknown]: DE

Ist CN=Heinz Mustermann, OU=Android developer, O=Uni HH, L=Hamburg,
ST=Hamburg, C=DE richtig? [Nein]: ja

Erstellen von Schlisselpaar (Typ RSA, 1.024 Bit) und selbstunterzeichnetem Zerti-
fikat (SHA1withRSA) mit einer Gultigkeit von 10.000 Tagen

far: CN=Heinz Mustermann, OU=Android developer, O=Uni HH, L=Hamburg,
ST=Hamburg, C=DE

Geben Sie das Passwort fiir <alias_name> ein.

(EINGABETASTE, wenn Passwort dasselbe wie flr Keystore):

Geben Sie das Passwort erneut ein:

[my-release-key.keystore wird gesichert.]

Kommandozeilenfenster wahrend der Ausfihrung von Keytool.exe

Nachdem der Keystore mit dem privaten Schliissel erzeugt worden ist, kann jetzt die fertige
Android Anwendung im release mode kompiliert werden. Fertige Android Anwendungen ha-
ben die Endung ,.apk®.

Dazu klickt man in Eclipse in dem Package Explorer mit der rechten Maustaste auf Projekt
welches exportiert werden soll, Android Tools > Export Unsigned Application Package.

1 = Android Manifest
4 I HellpA=ameid
LY New (|
P fthe AndroidManifestxmi
. Open in New Window f‘"“"d"c'd
a Open Type Hierarchy o
[ Show In Alt+ShiftsW » |
Copy ctieC |
& Copy Qualified Name |
T Paste Culev |
% Delete Delete OO® OO A:
Build Path v |
Source AltsShift+S » A
Refactor Alt+Shift+T »
2 Import...
3 Export..
2 Refresh Fs
Close Project
Assign Working Sets...
Run As
Debug As » Jution, you have the following options
Team » |and sign an APK
Compare With > Jnit manually
Restore from Local History... |
Android Tools 2 » | g New Test Project... \
Configure » | i NewResource File...
Properties Alt+Enter Export Signed Application Package...
| O TR Ieroment Export Unsigned Application Package... 3
XML Source: Directly edit the

Fix Project Properties

n: Documents

Abbildung 4. Exportieren einer unsignierten Anwendung.
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Alternativ geht es im Android Manifest > Exporting > Export an unsigned APK.

Android Manifest

+ Manifest General Attributes

Defines general information about the AndroidManifest.xmn|

Package com.example.helloandroid
Version code 1
Version name 1.0

Shared user id

Shared user label

Manifest Extras e E OO Az
() Uses Sdk —
Remove...
Up
Down
~ Exporting

To export the application for distribution, you have the following options:

& Usethe Export Wizard to export and sign an APK

* Export an unsigned APK and sign it manually

+ Links
The content of the Android Manifest is made up of three sections. You can also edit the »
[E] Application: Activities, intent filters, providers, services and receivers.
[E Permission: Permissions defined and permissions used.
(1] Instrumentation: Instrumentation defined.
XML Scurce: Directly edit the AndroidManifest.xml file.
Documentation: Documentation from the Android SDK for AndroidManifest.xml.

Manifest | Application | Permissions | Instrumentation | AndroidManifest.xml

Abbildung 5. Exportieren einer unsignierten Anwendung tber die Manifest-Ansicht

14
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Apk Datei signieren

Nachdem die Anwendung nun als apk Datei vorliegt, kann diese signiert werden. Daftr wird
ein weiteres Tool jarsigner.exe bendétigt. Jarsigner liegt in JavaSDK/bin Ordner.

Mit diesem Befehl wird die Apk Datei signiert:

jarsigner.exe -verbose -keystore my-release-key.keystore my_application.apk
alias_name

Dabei muss man den zuvor angelegten Keystore, die zu signierende Anwendung und den
gewunschten Schliissel angeben. In unserem Fall ist das Keystore: my-release-key.keystore,
Anwendung: my_application.apk und Schlissel: alias_name.

Die Konsolenausgabe sieht so aus:

PS C:\Program Files\Java\jdk1.6.0_18\bin> jarsigner.exe -verbose -keystore
my-release-key.keystore C:\HelloAndroid.apk alias_name
Enter Passphrase for keystore:
Enter key password for alias_name:

adding: META-INF/ALIAS_NA.SF

adding: META-INF/ALIAS_NA.RSA

signing: res/layout/main.xml

signing: AndroidManifest.xml

signing: resources.arsc

signing: res/drawable-hdpi/icon.png

signing: res/drawable-Idpi/icon.png

signing: res/drawable-mdpi/icon.png

signing: classes.dex

Nachdem die Anwendung signiert wurde, muss diese Anwendung noch optimiert werden.
Dafr ist wird das Tool zipalign.exe benutzt. Zipalign.exe liegt in AndroidSDK/tools Ordner.

Mit folgendem Kommando, wird das Programm optimiert. Der erste Parameter
(your_project_name-unaligned.apk) gibt die noch nicht optimierte Anwendung, der zweite
Parameter (your_project_name.apk) die optimierte Anwendung an.

zipalign.exe -v 4 your_project_name-unaligned.apk your_project_name.apk

Weitere Informationen zur Zipalign.exe findet man in dem Android Deleloper Blog®.

3 http://android-developers.blogspot.com/2009/09/zipalign-easy-optimization.html
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Die zuvor gemachten Schritte wie das Anlegen eines Keystores inkl. Schliisseln, Signieren
und Optimieren der Anwendung, kann man bequem mit Eclipse ADT Plugin erledigen.

Dabei klickt man mit der rechten Maustaste auf das Projekt > Android Tools und wéhlt Export
Signed Application Package aus. Alternativ geht es Uber: File > Export > Android > Export
Android Application. Nach der Auswahl des zu exportierenden Projektes, wird man gefragt,
ob ein vorhandener Keystore benutzt werden soll oder ein neuer angelegt werden soll.

3 Java - HelloAndroid/AndroidManifestxml - Eclipse SOK 0 L 0 i i o ae
File Edit Refactor Run Source Navigate Search Project Window Help
3~ B S8id: $-0-Q- BHFCG- @F~ R iE-E-%e
14 Package Ex £3 18 Hierarchy| = O || i) HelloAndroid Manifest 82 _[J) HelloAndroid.java @ stringsxml
. = = || % Android Manifest
4 = HelloAr"—" -
@ New » Fibutes
B src : :
b &8 gen Go Into on about the AndroidManifest.xmi
‘ A .
‘ l‘l\ nd Opany i Blew Wandow example.helloandroid
> asse
. &5 res Open Type Hierarchy F4
i3 And Show In Alt+Shift+ W »
=| defa _ !
= [iZ] Copy Ctrl+C
55 Copy Qualified Name
[ Paste Ctri+V
¥H Delete Delete OO ® 0 O A:
Build Path » :
Source Alt+Shift+S » [ Add... }
Refactor Alt+Shift+T » Remove,
g Import.. 5
s Export.. Do
.:f;’ Refresh F5
Close Project
Assign Working Sets..,
Run As »
Debug As » | for distribution, you have the following options:
Team » | to export and sign an APK
Compare With » PK and sign it manually
Restore from Local History...
SCA * hid Manifest is made un of three sections. You can also e
Android Tools »  Ji New Test Project...
Configure » @ NewResourceFile...
Properties Alt+Enter Export Signed Application Package...
W XM Setrce: Direct Export Unsigned Application Package...
1§ Documentation: D¢ R g 2.
Fix Project Properties
Manifest  Application P
Abbildung 6. Exportieren einer Anwendung mit ADT
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3.1 Android Market

Um eigene Anwendung auf Android Market zu verdffentlichen, gibt es einige Voraussetzun-
gen die zuerst erfullt werden missen. Hat man die obige Voraussetzungsliste abgearbeitet,
S0 erubrigen sich bereits viele Punkte.

Voraussetzungen vom Android Market Server:

e Anwendung muss signiert sein und Zertifikat-Ablaufdatum nach 22.10.2033
e android:versionCode und android:versionName mussen definiert sein
e android:icon und android:label miissen definiert sein

Weitere Voraussetzungen:

e Google Konto
e kostenpflichtige Registrierung als Entwickler auf Android Market

3.2 Endgerat

Um eine Fertige Anwendung auf ein Endgerat zu ubertragen, gibt es drei Moglichkeiten.

Android Debug Bridge Tool

Die erste Mdglichkeit ist das Android Debug Bridge Tool (adb.exe) welches in Android
SDK/tools Ordner liegt, zu benutzen. Damit lassen sie Anwendungen auf den Emulator
oder angeschlossenes Gerat installieren. Folgende Befehle installieren die Anwendung
~-Myapp.apk®:

adb.exe —e install Myapp.apk installiert auf den Emulator
adb.exe —d install Myapp.apk installiert auf ein verbundenes Physisches Gerat

Falls die Installation nicht klappen sollte, muss man auf dem Android Gerat unter Einstellun-
gen > Anwendungen > die Option Unbekannte Quellen aktivieren.

Dalvik Debug Monitor Server

Die zweite Mdglichkeit Anwendungen auf Endgeréte zu installieren, stell der Dalvik Debug
Monitor Server (DDMS) dar.

Zunachst muss in Eclipse die DDMS Perspektive gedffnet werden. Danach unter Device das
Geréat auswahlen auf dem das Programm installiert werden soll. Dann im File Explorer nach
Data/app Ordner navigieren und oben rechts den Knopf (,push a file onto the device®) betati-
gen. Zum Schluss wird man aufgefordert die Anwendung auszuwdahlen, welche installiert
werden soll.
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Abbildung 7. Eclipse in DDMS Perspektive
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Weitere Informationen zur ADB, DDMS und vielen anderen Tools, findet man auf der

Android Developer Homepage®.

Von SD Karte installieren

Die letzte Moglichkeit wie man eine Anwendung installiert ist ebenfalls einfach. Es wird eine
fertige und signierte apk Datei auf die Speicherkarte kopiert. Danach kann man mit verschie-
denen Programmen wie z.B. Applnstaller, apk Dateien von SD Karte installieren.

4 http://developer.android.com/guide/developing/tools/ddms.html
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